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August 2017 Update 3 (Build 20.5.164)
U.S. Payroll Tax Tables—August 2017 Update 3
Payroll tax tables have changed for the following jurisdiction:
Maine
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July 2017 Update 2 (Build 20.5.163)
U.S. Payroll Tax Tables—July 2017 Update 2
Payroll tax tables have changed for the following jurisdictions:
Idaho
Illinois
Kansas

Fixes in the July 2017 Update 2
We have fixed the following issues in this product update:
n

n

n

In the 6-1-5 Cost Summary report, the This Period column is correct even when the report spans three or
more years.
Users who do not have access to a custom field in a Sage 100 Contractor window no longer receive an error
when they try to open that window.
You can now use parentheses in a PO# or Subcontract# (for example, 1345-5143(2)). Previously, if these
numbers used parentheses, you could not post a payable invoice against the record or generate accurate
reports of payable invoices that referenced the record.

Fixes for the Canadian Edition
The following issue was fixed specifically for the Canadian edition:
n

The Collected Amount on the 2-11-21 GST/HST Report now correctly includes service invoices and the
amounts are consistent with the 2-11-22 GST/HST Summary Report.
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July 2017 Update 1 (Build 20.5.158)
Canadian Payroll Tax Tables—July 2017 Update 1
The following provinces and territories mandated payroll tax changes, effective July 1, 2016:
Prince Edward Island
Saskatchewan
For detailed information on personal amounts, see the TD1 form for each province or territory.

U.S. Payroll Tax Tables—July 2017 Update 1
Payroll tax tables have changed for the following jurisdiction:
New York City

Fixes in the July 2017 Update
We have fixed several issues in this product update.

Fixes for Both Editions
n

n

n

n

You can set up billing for a job in the 3-10-1 T&M Billing Setup window without receiving an error saying
"Unable to complete operation."
When you import time entries from Sage Construction Anywhere, Sage 100 Contractor now uses the
higher of the paygroup’s pay rate or the employee’s standard pay rate if you selected the Use Higher Rate
(Emp or Paygroup) option in the 5-2-2 Payroll Records window or the 5-5-1 Daily Payroll Entry
window.
You no longer receive an error message saying “Index was outside the bounds of the array” when
previewing a custom report.
In the 11-3 Dispatch Board, when you use the recently added Preferences setting for displaying
unassigned orders for a specified date range, the date range is now set correctly.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:
n

n

n

In the 5-2-5 Direct Deposit File Manager window, you can create a file for direct deposit that is accepted
by the Royal Bank of Canada. You no longer receive a message from the bank telling you that you have
duplicate payments.
In the 4-2 Payable Invoices/Credits window, when an invoice has a reference to a subcontract, you can
change the holdback amount(s).
When you export a purchase order from a takeoff, the export process no longer changes the tax totals
(shown at the bottom of the 6-6-1 Purchase Orders window) for all purchase orders.
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Note: This error did not affect the calculation of tax for invoices, and probably has no practical impact on
your data. However, if you exported purchase orders from takeoffs using the Canadian edition, please
contact Customer Support for an easy data repair.
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Enhancements in version 20.5
This section describes the new features and enhancements you will find in version 20.5.

We've been listening to you!
Sage thanks you for your product ideas! In version 20.5, we have incorporated several of the top-ranking
suggestions, which are listed here. Later sections describe changes that require more detailed explanation.
You can create and use unlimited custom fields in most records. These custom fields are more
versatile than the existing user-defined fields, which remain available in the program.
Thank you to all our customers who have requested this feature!
You can tag rows in the 9-5 Takeoffs grid, marking them for future follow-up, and you can add a note
to remind you why you tagged the line (for example, “Check this number with subcontractor XYZ”).
You can apply different display colors for each company desktop that you work with so that you can
easily distinguish one company from another when you have multiple companies open at the same
time. You select the color on the General Information tab of the 7-1 Company Information window.
Thank you Michelle M. for this suggestion.
The 2-4-51 Subsidiary Ledgerreport now includes totals by G/L subaccount, similar to the 2-4-51
Subsidiary Ledger~Land report.
Thank you Neil B. for this suggestion.
In response to the demand from many customers, we have expanded the capacity of most fields
(over 500!) throughout the program. (For example, in the 11-2 Work Order/Invoices/Credits
window, you can use 75 characters for the Description field. Previously, you could enter
45 characters.)
Thank you to:
Mike W. and Adam, who asked for longer Description fields.
Donald V., who asked for a longer AP Invoice Number field.
Jessica R., who asked for longer Purchase Order fields.
Jennifer F. and Alex L. for asking for longer Client Name fields.
Michell and Angela for also asking for longer client Address fields.
The 4-4 Vendors window shows checks written in the 1-1 Checks and Bank Charges or the 1-3
Journal Transactions window, so that you can see a complete payment history for a vendor,
regardless of where which window you used to pay the vendor.
Thank you Rhiannon T. for this suggestion.
W-2s that you send electronically are now sent to the email addresses used for sending Direct
Deposit information to employees, rather than to the address on the General Information tab in the
employee record.
Thank you Donna L for this suggestion.
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The 6-1-4 Job Summary Report window provides two new reports that compare budgeted hours to
actual hours:
The 6-1-4-81 Job Hours Summary Actual/Budget~With Uncomputed Payroll report lists job
hours that are over and under budgeted hours for all cost codes that have a budget for hours. This
report includes uncomputed payroll and daily payroll.
Note: Optionally, you can include hours for cost codes that have no budget for hours, and you
can choose to print separate reports by supervisor.
You can drill down from this report to the 6-1-3-41 Job Labor Hours window from the cost code
and the job.
The 6-1-4-82 Job Hours Summary Actual/Budget~Finished Jobs By Supervisor report
shows over and under budget hours, printing one line per job for completed and closed jobs.
Note: Optionally, you can include hours for cost codes that have no budget for hours, and you
can choose to print separate reports by supervisor.
You can drill down from this report to the 6-1-3-81Job Hours Summary Actual/Budget~With
Uncomputed Payroll report from the job.
Thank you Gregory S. and Sherry M. for this suggestion.
Users who do not have access to 5-2-2 Payroll Records cannot view earnings and payroll from the
5-2-1 Employees window.
Thank you Tom O. for this suggestion.
You can use new options for viewing record and field history for header fields and global values in the
9-5 Takeoffs window. (You do not view history for individual details from the details grid.)
Thank you Andrea C. for this suggestion.
You can use a new Change Period for Posted Records option in the 5-2-2 Payroll Records
window to change the period of a payroll transaction that you posted to the wrong period.
Thank you Terry T., Kathy D., and Jeffrey C. for this suggestion.
The 12-1-2-21, -22, -31, and -32 Quantity on Hand reports now include manufacturer part numbers,
which is convenient when counting inventory.
Thank you Jon McC. for this suggestion.
When you set field-level security on the contract amount, users without access cannot view the
Contract Summary.
Thank you Holly F. for this suggestion..

Use new custom fields in most windows
With version 20.5, you can define an unlimited number of custom fields for most Sage 100 Contractor
windows.
Custom fields enable you to store additional information that you want to keep with Sage 100 Contractor
records. As a company administrator, you can add, edit, or delete custom fields for any window that supports
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them. You can create custom fields for most types of records, except ledger transactions, accounts, daily
payroll, and recurring transactions, and you can create an unlimited number of custom fields for a window and
for your Sage 100 Contractor company.
Custom fields are not the same as the user-defined fields (UserDef1 and UserDef2) that come with the
software. Custom fields are more versatile than the limited user-defined fields.
Note: Windows that support custom fields include a new Custom Fields option on the Edit menu, and
an [Enter Optional Fields] button on the toolbar.
When you select the Edit > Custom Fields option or click the [Enter Custom Fields] button:
If any custom fields have been defined for the parent window, the Custom Fields window opens.
You can display the custom fields and change the custom field values for a record you are working
with.
If no custom fields have been defined for a window and you are signed in as a company administrator,
the Custom Field Properties window opens.
The following sections describe how you use these windows to create and view custom fields for your Sage
100 Contractor company.

About the Custom Fields window
The Custom Fields window displays a list of the custom fields that have been defined for the parent window.
You use the Custom Fields window to view or to enter values for custom fields that have been added to a
parent window.
If you sign in to Sage 100 Contractor as a company administrator, you can also add new custom fields or
modify or delete existing ones:
You click the [Add] button in the Custom Fields window to open the Custom Field Properties window
where you can define a new custom field for the window you are working in.
You click the [Modify] button to open the Modify Custom Fields window.
In the Modify Custom Fields window, use the icons beside the field you want to modify to:
Edit the properties of the field (
Delete the field (

).

).

Move the field up or down in the list (

).

Tip: If you want to keep the Custom Fields window open while you work with a record, click
[Pin]. The window remains pinned to the top right edge of the parent window until you unpin it,
even if you close and then reopen the parent window later. To unpin the window, click [Unpin] in
the Custom Fields window.

Defining Custom Fields for a Window
If you log on as a company administrator, you can define custom fields for any window that supports them.
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Sage 100 Contractor does not limit the number of custom fields you can define for a window or for your
company.
You use the Custom Field Properties window to add, edit, and delete custom fields.
Before you start
Make sure you are logged into Sage 100 Contractoras a company administrator. You can add, edit, or delete
custom fields only if you are logged in as a Company Administrator:
To add a new custom field:
1. In a window that supports custom fields, click Edit > Enter Custom Fields, or click the Enter custom
fields

button on the taskbar.

If no custom fields have been defined for the window, the Custom Field Properties window appears
immediately.
If any custom fields exist for the window, the Custom Fields entry window appears. In the Custom
Fields window, click [Add].
Tip: If you want to modify or delete an existing field, you click the field in the Custom Fields
window, and then either:
Press F7 or
Click [Modify],
Then, on the Modify Custom Fields window, you click the Edit properties for this field
the Delete

button or

.button.

2. Fill in the fields in the Custom Field Properties window as follows:
a. In the Field Name box, type a unique name to identify the custom field, using six characters.
Note: You cannot save a custom field with the same name as an existing custom field that has
been defined for a window, and you cannot change the name after you save the custom field.
b. In the Description box, type a brief description for the custom field, using up to 30 characters.
c. From the Field Type list, select the type of data this field will contain. For example, if you will use
the field to store a type of number, select Number.
Note: You cannot change the field type after you save the custom field.
d. Depending on the Field Type you selected in the previous step, fill in additional attributes for the
custom field:
Length. For Character field types, enter maximum number of characters (use up to 255
characters) that the custom field can accept.
Decimal Places. For Number field types, select the number of decimal places (0, 2, 4, or 6) that
numeric entries will use.
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Maximum Value / Minimum Value. If you want to track a standard currency value, you need to
set maximum and minimum values. The maximum value must be no greater than 999,999,999
and the minimum value should be no less than -99,999,999, the default values for these fields.
Numeric fields must have a maximum value greater than zero. You cannot use the same values
for Minimum Value and Maximum Value.
Prompt. For all field types, type a prompt to help users understand what to enter in the custom
field when they are processing records.
Default Entry. For all field types, type or select (if a list is available) the entry to display as the
default for the field.
Character fields can accept default entries, but not "Next" or "Previous."
Date fields display the date that occurs the number of days you specify after the current date
("TODAY").
Check boxes can be selected, or not, by default.
e. Set other options as follows:
Require Entry. Requires an entry, or Sage 100 Contractor will not save the record.
Use Quick List. You can provide a Quick List control for a customer field by selecting the Use
Quick List check box.
Require List Match. Requires that the entry match an item on the Quick List.
Lock Quick List. Prevents users from editing a Quick List. Only a company administrator can
edit the information.
Lock After Save. Prevents users from editing the information after saving the record. Only a
company administrator can edit the information.
Require Unique. Prevents users from entering duplicate information. This is available for
indexed text boxes that let you enter character-based information.
Check Spelling. Checks the spelling when you move to another text box or cell. If Sage 100
Contractor finds a misspelled word, it displays the Spelling dialog box.
Mixed Case. Allows text entry in upper and lower case.
Upper Case. Displays text only in upper case.
Lower Case. Converts entry to lower case text.
f. On the Permit Access to list, select the user groups that should have access to the field. If you do
not select any user group, all user groups have access.
3. Click [Save].

Tag rows for follow-up in the 9-5 Takeoffs grid
You can tag rows in the 9-5 Takeoffs grid, marking them for future follow-up. When you tag a row, you can add
a note to remind you why you tagged the line (for example, “Check this number with subcontractor XYZ”).
Headers for rows that you have tagged in the takeoff grid display a red triangle, helping you to identify them.
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To tag a row in the 9-5 Takeoffs grid:
1. Right-click any field in the row that you want to tag.
2. On the shortcut menu, click Add/Edit Row tag.
A Row Tag window appears. It identifies the bid item, phase, and row number of the row you are
tagging. It also provides space to enter a note.
3. In the Tag Note box, type the reason you are tagging this takeoff detail.
4. Click [OK].
To view a single tag note later, you can open the Row Tag window for the detail, just as you did to tag the
detail.
To view a list of all the tag notes for the entire takeoff, click the [RowTags] button at the bottom of the
window. In the Takeoff Row Tags for Job# window that opens, you can select a row tag, and then:
Click [Go to Row] to go to that detail in the takeoff grid.
Click [Remove] to remove the note and the tag for one or more selected rows.

Audit Information Available in Advanced Company Settings
In Database Administration, on the Advanced Settings tab, Advanced Company Settings displays information
about the total size of the selected company database, the size of the audit (history) tables, and the
percentage of the database used by the audit tables. This information is designed to help you optimize the
length of time to retain audit history.
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Automatic calculation for numeric fields
In most numeric fields that have decimal values, when you enter an arithmetic operator (such as +, -, *, or /),
Sage 100 Contractor evaluates the arithmetic as you type it, displaying the result as you go. For these fields,
the calculator no longer appears because the calculation is automatic.
For numeric fields on the 9-3 Assemblies and the 9-5 Takeoffs windows, you still use the calculator to
perform arithmetic operations. The program displays the calculator when you press an arithmetic operator, as
in previous versions.

Easier Access to User Subfolders for Workgroups
If you use Sage 100 Contractor in a workgroup environment, you will find it easier to access your user folder
on your Sage 100 Contractor server.
Sage 100 Contractor automatically creates a user folder on the server with the permissions you need to
access it from your workstation. You no longer need to create matching accounts on both your workstation
and the server, ensuring that they also use identical credentials. Sage 100 Contractor manages the server
folder for you.

Correct the period of a posted payroll transaction
If you post a payroll transaction to the wrong period, you can use the new Change Period for Posted
Records option in the 5-2-2 Payroll Records window to correct the period.
This procedure updates the existing record directly to move it to the new period, rather than reversing and
replacing the existing record.
Before you start
Note: You must log into the company as an administrator with exclusive access to use this feature.
To correct the period of a posted transaction:
1. Open the 5-2-2- Payroll Records window.
2. On the Options menu, click Change Period for Posted Records.
The Change Posted Payroll Period window opens.
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3. Enter criteria to select the payroll records that you want to change.
4. From the Change Period To box, select the correct period to which to post the payroll records.
5. Click [Preview Records] to view a list of the records that match your selection criteria, and verify that
these are the records you need to change.
If the list contains unexpected results, adjust the criteria until only the records you want to change are
included.
6. Click [Change Records] .
Sage 100 Contractor:
Updates all payroll records that have a ledger reference, including Void records.
Updates the general ledger and job and equipment costs with the new period and fiscal year.
Recalculates the ledger balances.

Save Time During Takeoff by Skipping Automatic Calculation
In the 9-5 Takeoffs window, you can select a new Remind to Save option to remind you to save takeoffs at a
specific interval. When you select this option, a Reminder Setting window appears, prompting you to specify
the frequency of the reminders.
The Reminder Setting window also includes a Save without automatic recalculation check box. If you
select this check box, you avoid recalculating a takeoff each time you save it. If your company has large
takeoffs, selecting this option can save you considerable time. You can calculate the takeoff at any time, and
the takeoff is calculated automatically whenever you open or save a takeoff.
Once selected, these options are saved as defaults for your company.
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Filter cost codes by Job and Phase in Lookup windows
When you search for cost codes in a lookup window, you can apply filters to include only the cost codes that
pertain to a specific job and phase or you can display all the cost codes you use for your company. A filtered
search is very efficient, especially if your company has a large number of cost codes and you are interested
only in cost codes for a particular job.
You can use three types of filters to search for cost codes:
All
Job
Job/Phase
When searching for cost codes, the filters that are available depend on the structure of the job and budget:
If a job has a budget, you can select a filter.
If the job has a budget but no phases, you cannot filter by Job/Phase.
If the job has no budget at all, no filter is available.
If you set up a job with phases, and each phase has a budget, the search yields only cost codes included in
the budget for that job and phase. If the job has a budget but no phases, the search yields only the cost codes
for the job. If there is no budget, the resulting list includes all the cost codes in your company database.
Filtering rules also apply to cost divisions. If the budget has no cost codes for site work and you select the site
work division, the search yields no results. To see the site work cost codes, you must switch the filter to All .

Filter unassigned work orders on the Dispatch Board
The Dispatch Board includes a setting that enables you to filter unassigned work orders that do not fall within
a specified date range. If you have a large number of unassigned work orders, excluding old orders and orders
that are too far in the future enables the program to display and process work orders more efficiently, and it
makes the Unassigned Column easier for you to work with.
To filter unassigned work orders that fall outside a date range:
1. On the Dispatch Board window, click Settings > Preferences.
2. In the Dispatch Board Preferences window, on the Unassigned Column tab, select the Include
unassigned items that are less than [ X ] days old or scheduled less than [ X ] days in the
future option.
Only unassigned work orders that fall within the prescribed range are displayed on the Dispatch Board.

New Option for Company-Specific Custom Reports and
Forms
You can now create reports and forms for a specific company that are accessible to all users when they print
reports for that company.
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To modify an existing company-specific report or form, later, select Display Company Reports or Display
Company Forms.
Company-specific reports and forms are located in the Sage100Con > Company > [company] > Files >
Custom Reports or the Sage100Con > Company > [company] > Files > Custom Report Forms folder,
respectively.

Use a new standard calendar to select dates
Sage 100 Contractor now displays a standard calendar as the date picker for date fields.
To select a date:
1. Press F5 or click the Display calendar button in a date field, or select Display calendar from the
shortcut menu on a date cell in a grid.
If you selected a date previously, that date is highlighted in the calendar.
2. Double-click the date you want to use.
You are returned to the date field, which now displays the date you selected.
Tip: If you prefer to use the old company calendar, simply press F2 after clicking in the date field.

Support for Microsoft SQL Server 2016 and Windows 2016
Server
Version 20.5 now supports the following Microsoft products:
Microsoft Windows Server 2016 Standard
Microsoft Windows Server 2016 Essentials
Microsoft SQL Server 2016:
Note:
The Sage 100 Contractor installer continues to offer to download and install Microsoft
SQL Server Express 2014 for new installations.
Backups created on Microsoft SQL Server 2014 can be restored on Microsoft SQL Server 2016.
However, you cannot use SQL Server 2016 to create backups in SQL Server 2014 format.
For current information about supported operating systems, Internet browsers, and other software, and about
system requirements for servers and client workstations, refer to our Knowledgebase article ID 79790,
available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=79790.

Other Improvements
When you open SQL Server Management Studio, a message reminds you that you should use Sage
100 ContractorDatabase Administration, instead, to perform maintenance and other
administrative tasks. )
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In Database Administration, on the on the Upgrade Company Databases tab, you can click a new
[Clear All] button to clear your selections of databases.
You can user the Copy User Files utility in Database Administration to copy a user's process maps
to another user.
Note: This task is separate from copying a user's default settings, which you can do using the 72-2 Users window in Sage 100 Contractor.
Version 20.5 supports Windows 10 high-contrast themes.
A new 5-1-2-31 Payroll Check Register~by Check Date report lists paychecks by check date.
The grids in the 3-7 Progress Billing and 12-2 Inventory Allocation windows now accept up to
5,000 detail rows.

Enhancements for the U.S. Edition
Sage 100 Contractor Version 20.5 includes the following enhancements to the U.S. Edition:
In the 4-2 Payable Invoices/Credits window and the 4-2 Vendors window, the Use Tax Rate and
Work Comp Rate fields now accept four decimal places.
The 5-1-5-21, -86, and -96 Workers Comp reports now show overtime hours for each employee in a
new Overtime Hours (or Ovt Hours) column. The Hours column is now called All Hours. Overtime
hours also appear in the Total and Details sections, and, if you select the Separate Reports By Job
check box, they appear in the Total by Job section in the 5-1-5-21 report.
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Fixes in Version 20.5
Fixes in the U.S. and Canadian Editions
Version 20.5 includes the following software fixes in both editions:
You no longer receive an error message saying that the record is assigned to a different client when
you search for a service contract in the 3-6 Receivable Clients window.
If you are a new Sage 100 Contractor user in a workgroup setting, you no longer receive a connection
error message if security settings prevent the creation of your user folder on the server. Instead, the
program creates your folder without restricted access.
In the 11-3 Dispatch Board, in the Column Setup window, you no longer receive a fatal error when
you type the name of the employer or vendor on a new row.
In the 9-7 Maintain Parts Database window, you can add new vendors to parts. If the preference
number you specify for the vendor has already been set for another vendor, the program assigns next
available number. When you click [Update Vendors], the program begins adding parts in the order you
entered them on the grid. If you this process before it has finished, you can choose whether to
continue save the changes up to that point, or to discard all the updates.
After updating parts, you can view a list of the changes. You can drill down from the list to a part, and
then edit the part.
Also, after deleting parts, you can view a list of any parts could not be deleted. You can drill down
from the list to the part to see why it could not be deleted.
In the 10-3 Schedules window, you can display more than 20 employees associated with a
scheduled task in the Employee grid.
The Dashboard no longer stops and closes Sage 100 Contractor if you add the Job Cash Flow, Job
Committed Costs, or Job Contract Budget Cost to Date panel to the Dashboard, and you do not
select jobs for them.
Database Administration displays a clearer, more informative message when there is a problem
connecting to the SQL Server instance.
In the 4-2 Payable Invoices/Credits window, you no longer receive an error when you save an
accounts payable invoice that has a secondary payee.
In the 9-5 Takeoffs window, you no longer receive an error saying that the file format is invalid when
you import project values.
When you change the user name in the 7-2-2 User List window for a user that is subject to job
security, Sage now updates the user name in all jobs where that user is included in the Job Access
List.
On the Takeoff Details tab of the 9-5 Takeoffs window, if you select a phase, then open the phase
list and add a phase with a lower number than the selected phase, when you return to the Takeoff
Details tab, the Phase box displays the originally selected phase and description, as expected.
On the Takeoff Details tab of the 9-5 Takeoffs window, deleting a Phase from the Phases list no
longer causes an error. (This happened in very specific situations.)
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In the 6-6-1 Purchase Orders window, you can leave the Account# column empty for a purchase
order if you do not have Service Receivables.
You can no longer acquire exclusive access to Sage 100 Contractor while others are already logged
into the company.
After you archive a fiscal year that includes invoices that were paid in a future year, invoice aging
reports match the balance in the control account.
When printing a 3-10-3-21-T&M Invoice--by Cost Type, the vendor name now prints correctly when
you use quotation marks in the description (for example, to represent inches).
If you set security on system menu items, and later remove the restrictions, the menu will be
restored properly for all users.
When you import a takeoff, you no longer receive an error message saying that the index is outside
the bounds of the array.
The 2-3-34 Income Statement--Last 12 Periods report now prints correctly on legal-sized paper
when printed according to a schedule.
In Database Administration, changing the number of days to retain a company's audit history no
longer causes an error.
The 2-8-21 Financial Report displays and prints much faster than in version 20.4.
In the 8-3 Equipment window, when you use the Alt + right arrow key or Alt + left arrow key, you
move through the record one field at a time, as in other Sage 100 Contractor records.
The 4-2 Payable Invoices/Credits window no longer creates duplicate job costs when you add
freight to an existing invoice.
In the 5-3-1 Payroll Calculations window, you can now clear the Disposable Earnings check box
if the Tax Type is 0-None and the Calculation Type is 1-Deduct from Employee for the payroll
calculation.
When you assign a priority to a work order using the Field Properties (F7) window in the 11-2 Work
Orders/Invoices/Credits window, the 11-3 Dispatch Board now respects that priority.
Note: A blank priority overrides the default 3 – Prompt and requires you to assign a priority in
the 11-2 Work Orders/Invoices/Credits window.
Inserting bid items in the 9-5 Takeoffs grid no longer causes the program to stop working or to create
duplicate takeoff lines.
In the 11-2 Work Orders/Invoices/Credits window, you can void invoices that have flat-rate
assemblies with parts pulled from inventory.
In Notes, the Check the spelling of checks icon on the toolbar works, even if you do not check a
spell-checking option. .
All buttons that query data outside the current window now enforce any menu-level security that has
been set for that data. For example, when you click the [Subcontracts] button in the 3-5 Jobs
window, the program ensures that you have menu-level security for the 6-7-1 Subcontracts window.
If you do not have the required permission, you receive a message telling you that you do not have
access rights for that option.
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Local payroll tax differentials are now computed correctly when the rate for the resident locale is
higher than the rate for the work locale. This situation could occur with Ohio city income taxes, for
example. (Differentials are set up in the 5-3-6 Local Payroll Tax window, where a “Y” is entered in
the Differential column in the tax grid.)

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:
Posting payable holdback invoices for Quebec no longer generates an audit error. QST is now posted
correctly to the QST Paid account.
You can now create a payroll record for vacation pay only, overriding all other calculations. Sage 100
Contractor posts a balanced entry to the correct general ledger accounts.
An improved 4-1-2-91 AP Invoice List~Holdback by Vendor report now shows the total holdback
for invoice totals in a new Totals section at the bottom of the report. (It no longer repeats the total for
each invoice line.) .

Fixes for the U.S. Edition
The following issues were fixed specifically for the U.S. Edition of Sage 100 Contractor:
In the 5-2-1 Employees window, on the ACA tab, you can now delete a row for a covered individual
and then save the Employee record without receiving an error.
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API for Third-Party Developer Products
This release provides the following enhancements to the API:
The API accepts blank passwords only for user IDs that are set up to use Windows Authentication.
Users who enter an ID that is set up for SQL authentication must also enter a password.
You can now use a blank line in requests to modify a Job, Vendor, or Client Contact.
Except in schedules, existing objects supported in the API now allow blank lines in grids, provided
the user interface permits the entry of blank lines.

n

n

• The API schema has been fixed so that the DailyPayroll object ServiceInvoiceRef uses a 20-character
limit string.
The EFT file generated for paying vendors now prepends the OriginatorCrossReferenceNumber field
with the letter “V” (Vvendor#) to differentiate it from the EFT for payroll records.
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Upgrading from version 19.8?
New Microsoft SQL Server Platform
Although Sage 100 Contractor 2017 has the same look, feel, and functionality that you are familiar with, its
new SQL database structure affords much tighter security and an up-to-date technology on which to build
future releases. It also provides several other notable enhancements, including:
A new, separate Database Administration tool. You don't have to be an expert user of Microsoft SQL
Server to take advantage of its robust features! We designed Database Administration to optimize
your data for Sage 100 Contractor, for example, by keeping related data in expected locations and
creating backups automatically before performing certain critical processes. Many of its features are
not available through SQL Server Management Studio.
Significantly, Database Administration includes a migration utility that we have designed and tested
extensively to help ensure a smooth and painless transition to SQL Server.
We have relocated many administrative utilities and functions from the main Sage 100 Contractor
program to this new tool. However, we have boosted their capabilities considerably, and now provide
easily scheduled maintenance and backup functions to help you to keep your Sage 100 Contractor
companies in good order.
In addition, Database Administration offers several powerful, new capabilities that enable you to
maintain tight security and exert fine control over user and program access to your SQL Server
instance.
For a comprehensive list of the utilities you will find in Database Administration, see “Database
Administration for Sage 100 Contractor”, later in this document.
Note: Database Administration comes with its own help system and a new Database and
Company Administration Guide to acquaint you with its features and to guide you in its use.
New views for creating reports with third-party report writers. Because the new views point to the
database tables, rather than pointing your reports directly to the tables, we encourage you to use
them when creating custom reports using third-party tools, such as Crystal Reports.
For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts
Payable vendor names in custom reports. In the version 20.5 company database, this information
resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table
name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in
the Views folder in your company database.
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Tip: A compelling reason to use these views is that they may not be affected by many types of changes
to the underlying tables, so future database changes will not necessarily "break" your custom reports.

Software and hardware required to support Microsoft SQL Server
Version 20.5 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.
When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configure Microsoft SQL Express for you.
Refer to Knowledgebase article 79790 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Database Administration for Sage 100 Contractor
The new Database Administration tool is intended for designated system administrators and company
administrators. You use it to set up and maintain your company databases, and to select advanced settings to
manage communications with and access to your Microsoft SQL Server instance from other programs.
If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For
example, Database Administration includes utilities for creating and deleting a company, backing up and
restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.
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Important! We highly recommend that you use Database Administration, rather than SQL Management
Studio®, to perform the database administration tasks listed below, even if you are an experienced SQL
Server user. Besides handling all the database tasks that you are likely to perform in a typical Sage 100
Contractor system, Database Administration was designed to optimize your data for Sage 100
Contractor, for example, by keeping related data in expected locations and creating backups
automatically before performing certain critical processes. In the rare event that you need to use SQL
Management Studio® to perform a task that is not provided in Database Administration, you should
contact Customer Support for assistance.
Database Administration includes the following database and company management utilities:
Create Company Based on Existing and Create Company create new Microsoft SQL Server
databases.
Rename Company and Delete Company are convenient utilities when working with existing
companies.
Deploy Sample Company helps you install and refresh the sample data that comes with Sage 100
Contractor.
Tune Up Company Databases performs various maintenance tasks to keep your database
functioning efficiently.
Back Up Company Databases enables you to back up your data "on demand," whenever needed.
Restore Company from Backup restores a backed-up copy of your database.
Upgrade Company Databases prepares your SQL company data so that it is compatible with the
most recent version of Sage 100 Contractor 2017.
Migrate Company Data and Migrate Custom Reports transfers your version 19.8 company data and
custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared
folders under \\ServerName\CompanyName, organized using a folder structure similar to earlier
versions.
Schedule Nightly Maintenance utilities enable you to schedule backup and maintenance operations
for times when other users are not logged into the system. You can also select the number of
consecutive backups to keep.
Manage Company Admins/SQL Logins utilities enable you to set up or delete logins to the SQL
Server database, and to designate a user as a company administrator for a specified Sage 100
Contractor company.
Advanced Company Settings lets you specify how long to keep history about database changes for
each company, including details about changed records, such as the date and user ID of the
employee made the change. Details older than the retention period you specify are cleared during
nightly maintenance. (This history is maintained in separate audit tables, which you can query using
SQL Server Management Studio.)
Advanced SQL Server Settings includes convenient, sophisticated access and memory
management controls for your SQL database.
Advanced Backup Settings lets you specify a backup folder if you prefer not to use the default folder.
You can also specify the number of days to keep "on demand" backup files.
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For detailed information about these utilities and how to use them, see the Database Administration help or
refer to the new Database and Company Administration Guide.

Additional Changes for SQL Server
In addition to the new SQL database platform and the Database Administration tool, you should note the
following important differences from earlier versions:
Because each user must now identify themselves to SQL Server using a unique SQL login, there is
no longer a single Supervisor user. Instead, you designate as Company Administrators users who
require elevated privileges in Sage 100 Contractor.
Tip: You can copy supervisor preferences used in version 19.8 to individual users in the version
20.5 User List window.
When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new
Connect to SQL Server window, and then you select your company and type of access from the
Company List window.
If you need to change the type of access after logging into the company, you can return to the
Company List window using the Change Company/Access link on the Sage 100 Contractor
desktop.
Note: If you want to log in as a different user, you must close Sage 100 Contractor completely
first, and then log in using a different user name.
You no longer need to reindex your data after upgrading. Now, you use the Database Administration
tool migrate your data from version 19.8 and to update it in future.
Version 20.5 and subsequent releases are installed to a different location than version 19.8 and earlier
versions.
Having separate installation locations enables you to run version 20.5 and version 19.8 on the same
computer while you migrate your data to the new version.
You need to install the License Administration application and activate the software on the same
computer as your version 19.8 license server, choosing the option to use the computer as the license
server for version 20.5. After installing Sage 100 Contractor on other networked workstations, point to
this machine as the license server.
For more information, see the Installation and License Administration Guide.

Notice about Supported Windows Operating Systems
Sage 100 Contractor 2016 supports Windows Server 2008 R2, and later versions of Windows. However, it
does not support Windows Server 2008 and Small Business Server 2008 because they do not support .NET
4.6.1, which this version of Sage 100 Contractor requires.
For current information about supported operating systems, Internet browsers, and other software, and about
system requirements for servers and client workstations, refer to our Knowledgebase article ID 79790,
available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=79790.
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Installing Sage 100 Contractor 2016
Installation of Sage 100 Contractor 2016 and upgrading your data involves a few more steps than in previous
editions because you need to install two additional components. You need to:
Install the Database Administration tool on the machine you will use as your server.
Create a SQL Server instance for Sage 100 Contractor. This process is simplified if you use the
option to download Microsoft SQL Server and create an instance automatically when you first open
For detailed instructions on installing Sage 100 Contractor 2016, see "Chapter 3: Sage 100 Contractor
Installation," in:
The Sage 100 Contractor Installation and License Administration Guide (U.S. Edition)
The Sage 100 Contractor Installation and License Administration Guide (Canadian Edition)

Printable checklists help you get started
Two printable checklists are available to help you get started using Sage 100 Contractor 2016. Download
them from our website, print them, and then check off each step on the printed list as you complete the
necessary tasks.
Use the Quick Start Checklist to help you stay on track when you set up your company or migrate
your company from version 19.8. It provides an overview of all the important steps you should
complete to install version 20.5
Use the "Going Live" Checklist when you are ready to start using Sage 100 Contractor 2016 in a
production environment (rather than a test environment). It lists all the important steps you should
complete to "go live" with Sage 100 Contractor 2016.

Other Enhancements Introduced in Sage 100 Contractor 2016
(SQL)
More versatile Lookup windows
Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows throughout the
program
Using the new Lookup windows, you can view information and select records in convenient new ways,
including:
Choose columns to display or hide in a Lookup window.
On the Options menu in any Lookup window, click Select Columns to Show, then select the check
boxes for each column you want to display in the Lookup window, or clear the check box to hide a
column from view.
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View the names associated with columns that display certain numbered records, for example, the
vendor names for vendor numbers, job names for job numbers, account names for account numbers,
and so on.
Sage 100 Contractor displays name columns automatically for these numbered records, identifying
them by enclosing the column heading in parentheses, for example "(Vendor Name)."
Note: You cannot hide these name columns while the associated number column is displayed,
although you can minimize the column width by dragging the right edge of the column header. If
you hide a number column, the associated name column is also hidden.
Change the order in which columns appear in a Lookup window.
Simply grab the column heading for a column you want to move, then drag it left or right until it is
positioned where you want it to be.
Note: If you separate a name column from its associated number column, the Lookup window
does not retain the new position the next time you open the Lookup window. The name column
always appears beside its associated number column when you open any Lookup window.
View more accurate results, and find records more quickly, when you begin typing a search term in a
data control box.
The new Lookup windows display only the records that begin with the characters you type, filtering
even more effectively as you continue typing.
When you see the record you want, select it on the list, and then press [Enter] to use it in the
transaction or other window you were working with.
When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns
appear as you want them the next time you use Lookup features in that window.

Simplified schedules lookup
In the 10-3 Schedules window, you can use a new Schedules button on the toolbar to look up jobs and
phases that are associated with a schedule.
When you select a job and phase in the Lookup window, the associated schedule appears in the grid in the 103 Schedules window.

Unique Payroll record numbers
After you archive payroll, payroll numbers continue in sequence, rather than starting from 1, as in previous
versions. The advantage is that payroll record numbers are now unique for a company, even across years.

View Change History in Records
Many data entry windows in version 20.5 include a new View menu, with options that enable company
administrators to view the history of changes to a selected record.
This capability can be helpful when you need to determine the source or the timing of a change in a record.
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Notes:
The depth of the change history is determined by the retention policy set for your company in
Database Administration. History is retained for 180 days by default, but you can change the
retention period.
You do not have to log into the company with Administrator rights to view history, providing you
are set up as a company administrator in the 7-7-2 User List.
When you display a record in a window that has a View menu, you can select one of two options to view
history:
View > Record history. When you select this option, a separate View History window opens,
displaying a list of all the changes to the current record.
Initially, the list summarizes all the changes to the record, showing for each change
The database table that was updated,
Whether new information was inserted or existing information was modified or deleted.
The date and time.
The login ID of the user who made the change.
The ID of the computer where the change originated.
The application where the change originated (for example, Sage 100 Contractor, Database
Administration, or SQL Server Management Studio).
Tip: If there were many changes, you can filter a long list to show only changes for a particular
table, user, or application.
To view the details of a particular change, click the row on which the change is listed. Sage 100
Contractor displays a History Details window that shows, for each field in the record, the value of
each field before and after the change.
View > Field history. When you select this option, field entries that have changed for the current
record are displayed against a yellow background.
To view change details for a particular field, click the field, and then press [F12]. Sage 100 Contractor
displays a separate History window for the field that lists the ID of each person who made a change,
the date of the change, the field values before and after the change, and the application where the
change originated.
Note: With View Field History turned on, you cannot edit the record.
The view history options are turned off when you close the window or move to another record.
Note: Although the following windows include a View menu, some special conditions apply:
In 5-2-1 Employees, history is not provided for the ACA tab.
In 5-2-2 Payroll Records, history is not provided for the the Calculations tab.
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Option for closing purchase orders automatically
In earlier versions, if you were a company administrator, you could select an option to close purchase orders
automatically. Sage 100 Contractor assigned the 4-Closed status to a purchase order when you posted a
receipt in the 4-2 Payable Invoices/Credits or 12-4 Purchase Order Receipts window that produced a zero
or negative balance on the purchase order.
As of version 20.3, the Options menu in the 6-6-1 Purchase Orders window provides a new option for closing
purchase orders automatically when you post a receipt that reduces all quantities to zero.
To have Sage 100 Contractor close purchase orders automatically:
1. In the 6--6-1 Purchase Orders window, click Options > Automatic Close.
2. On the Automatic Close menu, select one or both of the following options:
When Balance Is Zero or Negative. (This option was available in previous versions.)
When All Quantities Equal Zero. (That is, the purchase order is closed when the sum of the To
Date and Canceled columns equal the sum of the Quantity column. If any quantity remains, positive
or negative, the purchase order remains open.).
Note: The Automatic Close option is available only if you are a company administrator.

Support for Sage Exchange Desktop 2.0
In version 20.3, we upgraded Sage 100 Contractor to the latest Sage Payment Solutions technology, which
supports chip card-readers and EMV processing.

Support for Customized Tables and Views
Administrators and third-party developers can now add customized tables and views to Sage 100 Contractor
databases. Sage 100 Contractor reserves a special namespace designation for customizations, preventing
potential conflicts with future software development, or the creation of incompatible customizations.
Before you can add tables and views, you must create a schema with a name that begins with dbx_ to identify
it as a custom schema. Dbx_ should be followed by your company name or another unique label that will
distinguish it from other third-party schemas. For example, Rupert Everett Consulting could create a schema
called dbx_REVERETT.
You can then add tables and views to this schema, and you can add multiple schemas, as needed.

New window to add client service locations quickly
In the 11-2 Work Orders/Invoices/Credits window, you can use a new Add Service Location window to
add a new location. If you have a large number of locations for a client, using this new window to add a
location can be much faster than the location grid.
A new Create New Locations with Quick Add option is available from the Options menu. If you select this
option, when you type a new code in the Location field, press Enter, and then choose to add a new location
record, the Add Service Location window appears instead of the location grid.
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Whether or not you select the new option from the Options menu, you can open the Add Service
Locationwindow by first opening the Location lookup window, and then clicking either the Quick Add button
or the Options > Quick Add menu selection.
Note: You must enter a client in the 11-2 Work Orders/Invoices/Credits window before you can add a
new service location for the client.
Saving the location record adds it automatically to the Location lookup window.

Enhancements for the U.S. Edition
Sage 100 Contractor Version 20.5 includes the following enhancements to the U.S. Edition:
n

n

The Illinois Certified Report now breaks out prevailing and non-prevailing wage hours.
The Sales Tax Districts window now includes a column to show the effective tax rate for each tax district.
You can also add this column to the Tax Districts lookup window using the Options > Select Columns to
Show option in the lookup window.

Notes for Third-Party Developers
API Enhancements
The API supports adding and removing attachments on all Sage 100 Contractor forms that support
attachments and have API support for Add, Modify, and Delete.
As with the existing API for Work Orders, these changes do not include support for:
Changing the description on attachments
Web links

Other API enhancements include:
n

n

The API now includes the JobCostQry method to query the Job Cost table.
The API now provides three new methods to determine whether a Sage 100 Contractor database has been
opened exclusively, to set exclusive access, and to release a database from exclulsive access.
These methods are:
p

GetCompanyAvailability

p

GetExclusiveAccess

p

ReleaseExclusiveAccess
Note: If you submit a request for exclusive access to a company using the same instance of the API
that already has exclusive access to another company, you will lose exclusive access to the other
company.

n

You now receive an error if you try to insert or delete certain types of records, where a certain number of
records is required for the program to function properly.
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Because exactly one Company Information record must exist for a company, you cannot add more than
one company, and you cannot delete the Company Information record.
Because there must be exactly nine cost types, you cannot add or delete Cost Type records.
Because there must be exactly one database properties record, you cannot add or delete Database
Properties.
Because there can be only zero or one Ledger Setup record, you cannot delete the Ledger Setup record if
ledger transactions exist.
Schema Change for Global Variables
The API schema required a change for the TakeoffGlobalVariable object. Third-party applications that add,
modify, or delete TakeoffGlobalVariables objects must update formats as follows:.
ObjectRef is no longer associated with the VariableName element. It is now associated with a new
LineID element.
The Desc element now appears before VariableName.

Migrating your company data from version 19.8
Important! You must be using Sage 100 Contractor version 19.8 to migrate your company to version
20.5. If you are using an earlier version of Sage 100 Contractor, you must first upgrade your company data
to version 19.8.
You use the migration utility in the new Database Administration tool to automatically migrate and upgrade
your data to version 20.5, including all company data in folders and subfolders of …\MB7\[CompanyName].
Migrated files are located in shared folders under \\ServerName\CompanyName. These subfolders are
organized using a similar folder structure as in earlier versions, and include:
Aatrix Forms
Attachments
Direct Deposit
Images
Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100
Contractor. The remaining folders are created as needed.
Note: For detailed, step-by-step instructions on migration, see the Database and Company
Administration Guide or the Database Administration help.

Preparing for migration in version 19.8
Migration should proceed smoothly in most cases. However, you should audit your accounting data and your
company payroll in version 19.8, and then fix any errors, before attempting migration to version 20.5.
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Use the following audit tools to prepare your data in version 19.8:
1-6 Period and Fiscal Year Management > Audit Books
5-3-7 Payroll Audit
6-6-3 Purchase Order Audit
6-7-4 Subcontract Audit
12-5 Inventory Audit

Note: If your data includes serious audit errors, you may need assistance from your business partner or
consultant to prepare your database for migration.

Migrating reports
The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor
reports and reports written with the Sage 100 Contractor report designer.
In version 20.5, shared custom reports and form designs are located in these folders:
\\ServerName\Sage100Contractor\Custom Reports
\\ServerName\Sage100Contractor\Report Forms
Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated
with each user name, as follows:
\\ServerName\Sage100Contractor\User Data\username\Custom Reports
\\ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports
You also need to update custom reports created with third-party software, such as Crystal Reports, so they
map to the new database.
We recommend that you use the new report views that come with version 20.5 to create or update reports.
The new views were created for your convenience, so that future database changes will not necessarily break
your custom reports.

After migrating your company data
After migrating your data, you will likely need to perform the following additional steps to prepare your
company for use in Sage 100 Contractor:
Important! Use Database Administration, not SQL Server Management Studio, for all these tasks.
Add company administrators. There is no longer a generic "supervisor" user as there was in earlier
versions. All users must sign into the company using their personal IDs, and only users designated
as company administrators have heightened privileges previously associated with the "supervisor"
role. You can designate one user as a company administrator during migration, but you can add
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others later.
Add SQL logins for new users. If you have new users that did not exist in your version 19.8
company, add them as users to the SQL database.
You must also add them as users and assign security in Sage 100 Contractor.
Designate an additional SQL Server administrator. Only a user with system administrator
privileges for the SQL instance can administer users for SQL Server or assign the system
administrator role to another user. Therefore, it is vital at all times that more than one user has a
system administrator role. If the principal system administrator should suddenly fall ill, or leave your
company, or otherwise be unable to perform their duties, another person with administrative access
to the SQL Server database must be able to take over that role.
Note: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role
in SQL Server. When they designate a SQL Server administrator in Database Administration,
that person is also assigned the 'sysadmin' role in SQL Server.
Switch your Sage Construction Anywhere to version 20.5. If you have been using Sage
Construction Anywhere with Sage 100 Contractor version 19.8 and want to use it with version 20.5,
you will need to switch the connection to version 20.5. For help on switching the connection, see the
instructions in the Installation and License Administration Guide.
Migrate your Sage ACT! settings to version 20.5. If you have been using Sage ACT! with Sage
100 Contractor version 19.8 and want to use it with version 20.5, you need to change your ACT!
settings to point to your new version 20.5 company database. For help on migrating your ACT!
settings to version 20.5, see the instructions in the Installation and License Administration Guide.
Migrate each user's scheduled reports from version 19.8. See the instructions in the Installation
and License Administration Guide.
Migrate each user's alerts from version 19.8. See the instructions in the Installation and License
Administration Guide.

Changes to converted data
During migration, the program may encounter problems that might prevent it from writing a particular record to
the new SQL Server database.
If the problem is one that the migration program can fix, it repairs the record, and then writes the updated
record to the SQL Server database. (For a list of the types of errors that can be fixed during migration, see the
Database and Company Administration Guide.)
Note: Not all errors can be fixed during migration. In these cases, the record is not written to the new
database.
The migration log file
The program keeps a log of all changed records and records that were not migrated because of an
unresolvable error, unless the record was invalid in version 19.8. (Invalid records are neither migrated nor
logged.)
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After migration, you should check the log file to see what changes were made to your data during conversion,
or whether any records were not migrated to the new SQL database.
The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example,
C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more
detailed information about each error found.

Using Sage 100 Contractor Intelligence Reporting with Sage 100
Contractor 2017
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.
If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.5.
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 20.5.

General
Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests, accessing
Help, or downloading periodic product or tax updates all require Internet access.
To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on
has access to the Internet.
During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect
to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer
where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.
Note: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other
system requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other
firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.
You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring
other third-party firewall products.
To configure the Windows Firewall:
1. For Windows Server 2008, click Start > Control Panel > Security.
For Windows 7, click Start > Control Panel > System and Security.
For Windows 8.1 and Windows 10, click Start > All apps > Control Panel > System and Security.
2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.
3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected..
Note: By default, the exception is set to allow access by any computer on the network. You can refine this
setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the
computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 32-bit
C:\ProgramData\Sage\Sage 100 Contractor
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C:\Program Files\Sage\Sage 100 Contractor
C:\ProgramData\Aatrix Software
C:\Program Files\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 64-bit
C:\ProgramData\Sage\Sage 100 Contractor
C:\Program Files (x86)\Sage\Sage 100 Contractor
C:\Program Files (x86)\Aatrix Software
C:\ProgramData\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit
C:\ProgramData\Sage\Sage 100 Contractor
C:\Program Files\Sage\Sage 100 Contractor
C:\ProgramData\Aatrix Software
C:\Program Files\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
C:\ProgramData\Sage\Sage 100 Contractor
C:\Program Files (x86)\Sage\Sage 100 Contractor
C:\Program Files (x86)\Aatrix Software
C:\ProgramData\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional
C:\ProgramData\Sage\Sage 100 Contractor
C:\Program Files (x86)\Sage\Sage 100 Contractor
C:\Program Files (x86)\Aatrix Software
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C:\ProgramData\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows Server 2008 R2, 2011,
2012
C:\ProgramData\Sage\Sage 100 Contractor
C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
C:\Program Files (x86)\Aatrix Software
C:\ProgramData\Aatrix Software
C:\%LocalAppData%\Sage\Sage 100 Contractor
Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL Server
Version 20.5 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express at no
charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL Express,
and upgrade to the full version of Microsoft SQL Server later, if necessary.
When you first open the new Database Administration tool, the program tries to configure an instance of Microsoft
SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an instance of
Microsoft SQL Server, you can let the Database Administration tool download, install, and configure Microsoft SQL
Express for you.
Refer to Knowledgebase article 79790 for detailed information about supported operating systems and software, and
for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is not supported
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL Server on a
read-only domain controller should you encounter any problems with this configuration.
Because you must install Database Administration on the same machine as SQL Server, you should not install
Database Administration on a domain controller. To guard against inadvertent installation on a domain controller and
the potential for irrecoverable data losses, you will receive an error message if you attempt to install Database
Administration on a machine used as a domain controller .
For more information, see the Microsoft Knowledgebase article https://support.microsoft.com/en-us/kb/2032911.

About .NET Framework
.NET 4.6.1 Framework is required
If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install Sage
100 Contractor. Installation of .NET 4.6.1 Framework alone may take up to 20 minutes per computer.
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Make sure that both your client and server computers meet the minimum requirements for installing both Sage 100
Contractor software and .NET 4.6.1 Framework.
Note: If Sage 100 Contractor requires an installation of .NET 4.6.1 Framework, the Sage 100 Contractor
installation process may continue automatically after the .NET Framework installation is completed. If you are
prompted to restart your computer after the .NET Framework installation, you must do so to continue the Sage
100 Contractor installation.
.NET 3.5 is also required
In some situations, you may need to turn on .NET 3.5 manually by selecting the .NET 3.5 check box in the Windows
Features dialog box. For more information, see Knowledgebase article ID 68381, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.
Windows Small Business Server 2011 is not supported
Microsoft Small Business Server 2011 does not support .NET Framework 4.6.7, which Sage 100 Contractor (SQL)
requires. Unfortunately, this means that Sage 100 Contractor (SQL) cannot support Small Business Server 2011.
Turning on Microsoft .NET 3.5
Microsoft .NET 3.5 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008
R2 machine. Server 2008 R2 comes with .NET 3.5 loaded but not installed, so Sage 100 Contractor does not install
it automatically.
If you attempt to install Sage 100 Contractor without .NET 3.5 installed, you receive the following message during
the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the
installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5 has been installed. If you receive the above
message during installation, install .NET Framework 3.5., and then reinstall Sage 100 Contractor.
The following instructions are for Windows Server 2008 R2.
To verify that .NET 3.5 is installed on Windows Server 2008 R2:
1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane.
Verify that .NET Framework 3.5.1 is listed.
To enable .NET 3.5 on Windows Server 2008 R2:
1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to
.NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].
Note: Enabling .NET Framework 3.5.1 may require a reboot.
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About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750.
Certain configurations can potentially disable the communication:
You must enable file sharing on your computers. To enable file sharing, follow the instructions in the
Windows Help.
TCP communication requires the selection of port numbers that are not in use by other processes on the
local computer.
Software firewalls running on the local computer can be configured to block processes from opening TCP
ports, which will prevent communication through the TCP Remoting Channel.

Sage Advisor Update
Important! Sage Advisor Update is not available for version 20.5, until further notice.
You can download Version 20.5 from the Knowledgebase using the link provided in Software Notice 17-D.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card
companies as a guideline to help organizations that process card payments to prevent credit card fraud, cracking,
and other security weaknesses and threats.
A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to
process credit card payments and being audited and/or fined. (For more information about PCI standards, see
https://www.pcisecuritystandards.org/.)
Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to
seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing
program uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions
and process check and credit card transactions.
Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit
card transactions without storing your customers’ sensitive card information in your database. Sage Exchange
transmits check and credit card details through a secure connection to Sage Payment Solutions, where they are
stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties and credit card fraud.
Caution! To avoid non-compliance with PCI standards, do not store credit card information in Sage 100
Contractor. Such storage creates unnecessary risk for your business and your customers.

Using Sage 100 Contractor Intelligence Reporting with Sage 100 Contractor
2017
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.
If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.5.
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Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:
For updating forms and executable files.
For electronic filing (eFiling) of the forms.
If you experience an Internet connection problem, it may be due to problems communicating through an Internet
firewall. Firewalls need to have access allowed through specific ports:
The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site
http://updates.aatrix.com.
The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.
By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only
allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the
Internet.
For updating using http on port 80 to http://updates.aatrix.com:
aatrixforms.exe
updater.exe
updater2.exe
For eFiling using secure http on port 443 to https://efile.aatrix.com:
builder.exe
viewer.exe

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you
print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the amount paid
in the future period is allocated to the Current period or an aging period, depending on the due date of the retainage
and the date it was paid.
Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports
that reflect the true amount of retainage outstanding at year end.
Tip: If you archive your data at year end, you can also print the reports from the archive company, later.

Printing reports to PDF or exporting to Excel?
When you print reports to PDF, you may find that the size of the PDF file is unexpectedly large and the resolution of
the displayed PDF is not optimal.
To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in Compatibility
Mode (compatible with Windows 7), and then print the report.
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Note: You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if you use
Microsoft Office 2013.
We have not encountered this issue during testing, nor has it been reported for Windows Server 2012 R2.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than
8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.
Important! To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your
Windows operating system. For more information about installing the Windows Fax Service component, see the
Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start
on Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2
Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating systems. If the service
stops, the program displays a message advising you to take further action to resolve this issue.

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:
1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region .
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under Date and time formats, from the Short date format drop-down list, select the format used for your
country.
5. Click [OK].
6. Close the Clock, Language, and Region window.

Posting Status for a Company Created since Version 19.2
If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise after you
advance the year to the first period of the new fiscal year. The new year may not be available when you try to change
the posting period.
A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered this
issue, contact Customer Support for assistance.

Windows "Sleep Mode" prevents computers from obtaining a license use
If the computer you are using as a license server goes into sleep mode, other computers on the network cannot
obtain a license.
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To avoid this possibility, set Sleep Mode on your license server computer to Never.
To set the Sleep Mode to “Never”:
1. In Windows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control Panel
> System and Security > Power Options.
In Windows 7, click Start > Control Panel > System and Security > Power Options
2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Windows 8.1 Professional and Server 2012 Standard Operating
Systems
Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start
on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program displays
a message advising you to take further action to resolve this issue.

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server 2012
operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating
Systems
Launching Sage 100 Contractor to run as administrator for scheduling
reports
Important! On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “run as administrator” or to “run the program as administrator.”
Microsoft Windows changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating
systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you
have limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule,
you must launch Sage 100 Contractor with the command to either Run as administrator or Run this program as
an administrator.
When you select either command, the settings are limited to you personally. Your settings to run Sage 100
Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from this
computer. Your settings on this computer can either be temporary or persistent. For example, when you select Run
as administrator, you run the program as administrator for that session only. When you select Run this program as
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an administrator, you set program properties to always run the program as administrator when you log on to this
computer.
Note: "Run as administrator" and "Run this program as an administrator" are not related to Windows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program
you are running.
To set "Run as administrator":
1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, to launch the program, click Run as administrator.
Note: Selecting Run as administrator only runs the current session of running Sage 100 Contractor. The
setting does not persist after the session is over.
To set "Run this program as an administrator":
1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, click Properties.
3. On the Sage 100 Contractor Properties window, click the Compatibility tab.
4. Under Privileges Level, select Run this program as an administrator.
5. Click [Apply], and then click [OK].
Note: Selecting Run this program as an administrator always runs the program with these properties when
you launch the program on this computer. The setting persists.

Solution for Windows Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows
Server 2008 R2 operating system, follow these instructions:
1. On the Window desktop, right-click Start, and then click Open Windows Explorer.
2. On the left side of the window, under Computer > Local Disk, right-click the \Sage100Con folder, and then
select Properties.
3. On the Sage100Con Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click the Edit button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.
Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK].
7. On the Sage100Con Properties window, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operating Windows 2008 Server R2, you may see the following error
message when trying to open a photograph or image file in Sage 100 Contractor:
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"No application is associated with the specific file associated with this application."
This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet
enabled the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install
Desktop Experience using the Server Manager utility:
1. In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2. In the Server Manager window, click Features (left-hand pane).
3. In the Features pane, click Add Features.
4. Select the Desktop Experience check box.
5. If you are prompted to add additional features, click [Add Required Features].
6. Click [Next].
7. Click [Install].
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